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Aims
To show you how to make nice looking charts in
Excel:
1 Pie charts
A Single series bar charts
d Scatter plots

d Multiple series bar charts based on data from
pivot tables

Note: See Workshop 3 for how to evaluate charts
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Creating Pie Charts
1. Set up the file

u 3| &~ Powerstations3.xisx - Microsoft Excel o & =
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. . . 1 [Country  |Number
associated with this e ——

presentation e
2. Save it in a folder

SExcelCharts in your :
Documents area LR —

3. Open this file [

The background colour and zoom
4. Save it as have been changed to make the
PowerStations2.x|sx sheets more accessible. This does not
affect how the printout looks.
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2. Create an Initial Chart
ect the Alphabetical Order sheet

1.Se
2.5e
3.Se

ect all the data

ect Insert — Pie — then the flrst 2D ple Chart

Your display should
then look like this:
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3. Change the Chart Design

1. On the Design ribbon, move the chart to a new sheet
using the “Move Chart Location” button. This should
create a sheet called Chart1.

2. Click and drag the Chart1 tab in between the
Alphabetical Order and Numerical Order tabs\

W 4> M| RawData | Chartl / Alphabetical Order ; Numerical Order /%3
Ready | f] \
3. Change the chart style to Style 26
i ¥ PowerStations3.xlsx - Microsoft E--l\ [ : ‘ o &
Insert  Page Layout Formulas Data Review w  Developer Design Layout Format @ o
2.0 OO e

Note: You must change the chart style before you change
its layout and format
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4. Change the Chart Layout and
Format

. Select and change the chart title to
“The number of nuclear power
stations in various countries in 1989

. Format Data Labels

2. On the Home ribbon, change the title o
font size to 24 and the style to Arial

3. On the Layout ribbon, turn off the
chart legend by selecting Legend —
None

4. Under the Data Labels menu, choose
“Best Fit”, then select “More Data
Label Options™ then select “Category
Name” under “Label contains”

@@@ Peter Samuels Reviewer: Ellen Marshall
@ www.statstutor.ac.uk Birmingham City University University of Sheffield




5. Whilst the data labels are
selected, change their font size
to 16 and their style to Arial
using the Home ribbon

6. Select the chart background,
then change its colour to light
yellow by using Shape Fill pull
down menu on the Format L
ribbon (light yellow is the option
next to white on the Standard
“more fill colours” palette).

/. Save the file
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The completed chart should then look like this:

The number of nuclear power stations in various
countries in 1989

West Germany, 23\ Canada, 22

South Korea, 9

Sweden, 12

Spain, 10
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Creating bar charts
1. Create an chart

1. Save the file you created as PowerStations3.xIsx

2. Go to the Numerical Order sheet

. Select the data
and then select
Insert — Column
then the first
option under 2-D
Column

. This should
create a bar

chart that looks
like this:

‘ @ ®@@J www.statstutor.ac.uk

& & |- S EERE
m Home Insert Page Layout orm eview View eveloper sig ay orma 2@coF R
g g vazs Esazl ] In
MW & == | | [
change Savers | switen  select | ||ES) |l [ | [EHE 0 0 I 0 I [ ] I [ ] = Move
Chart Type Template Row/Column Data = = ! L i ! ! Chart
Chart Layouts Chart Styles Location
Chart fe v
A B C D E F G H | =
1 Country Number
2 USA 1
3 Soviet Union Number
4 France
5 Japan 140
6 UK 120 +
7 West Germany| 100 -—
8 Canada 80
9 Sweden 60 -
10 Spain 40 — . == B Number
11 SouthKorea | 20 - N BN B N ou
12 o/ N N N N .,. H = =
13 Q NS A 2 S Q 2
R Q2 N N ,bb ¥ 2 (3
14 S & & F e X E
15 3 +© &
¢ 2
16
17
M4 Raw Data —
Ready | 3 | Average: 40.4 =0 [

Peter Samuels
Birmingham City University

Reviewer: Ellen Marshall
University of Sheffield




2. Change the chart design

1. Move the chart to a separate sheet. This should
create a sheet called Chart2.

2. Move the sheet Chart2 to after the sheet
Numerical Order

3. Change the style of the chart to Style 4 by using
the Chart Style tool on the Design ribhon

\

PowerStations4.xlsx - Microsoft Excel ‘ W Chart.Tool: \ o B =R
Home Insert Page Layo i View sig ormat ¢ [A] @ o @ R
- N ] - [ B
Fag ] ‘ m
- IEE |l 7= Hir| |- || ST
hange Save As Switch Select il 1S —Jl—ﬂ- ==l =il | ] . . . l Move
hart Type Template = Row/Column Data ' ' : !
Data Chart Layouts Chart Styles

Reviewer: Ellen Marshall

@@@ Peter Samuels
@ www.statstutor.ac.uk Birmingham City University University of Sheffield




3. Change the chart layout and

format

. Select the chart title and change it to “The number of
nuclear power stations in various countries in 1989”

2.
3.

Use the Home ribbon to change the title to 24 point Arial font
Remove the legend using the Layout ribbon

4. AISO USing the Layout ations4.xlsx - Microsoft Excel

rlben, add a prmulas Data Review

It

IMI‘ AM{ |

horizontal axis title of

the selections shown—

Axis |Legend Data Data
e v |Titles ~ M Labels v Table v

“Country” by making //_] Primary Horizontal Axis Title »

|  Primary Vertical Axis Title

Developer Design Layout Format
LI ‘ (il | ll\'_hl A
Axes Gridlines Plot Trendline

Area~
None

Do not display an Axis Title
S— 3

Title Below Axis

here mber of nuclear poweﬁm Display Title below Horizontal Axis and
— ) resize chart
i More Primary Horizontal Axis Title Options...
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. Add a vertical axis title of
“Number”, also written
horizontally in a similar way.

. Use the Home ribbon to change
the font of these titles to 18 point
Arial

. Also using the Home ribbon,
select the axis labels and change

their font to 16 point Arial /

. Double click on the vertical axi
labels and change their
maximum value to Fixed and 120

Axis Options
Minimum: @ aute O Fixed

. Select the chart background then change its colour to light
yellow using the Format tab and the shape fill option

@@@ Peter Samuels
@ www.statstutor.ac.uk Birmingham City University

Reviewer: Ellen Marshall
University of Sheffield



This should create a chart that looks like this:

The number of nuclear power stations in various
countries in 1989
120
100 -
80 -
Number 60 -
40 -
I I I I
. I l m
0\00 0@
o“\ S 6°°
=) $Q)
Country

10. Save the file and close it
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Creating a scatter plot

1. Create an initial plot
1. Copy the file Endorphin.xIsx associated with this

presentation. g
2. Save this file as EOEEDR « anes a0 =
Endorphin2.xlIsx in e e ee e

the folder A : c o | | =]
5EXC6|ChartS On your ; Blood plasma beta endorphin concentration (ppa6l/I) g g
efore rac After race
computer e )
3. Select the Before > s
Race and After Race .
column data up to 072 378
10 20.2
row 14 9 219
12 (10.4 14.2
4. Select Insert — / 13|14 346
14 (17.8 46.2

Scatter and the first 15 8427273
scatter plot option ] a2em315
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The screen should then look like this:

%@ & [+ Endorphin3.xlsx - Microsoft Excel Chart:Tools
Home  Insert Page Layout Formulas Data Review View Developer | Design | Layout Format
Type Data Chart Layouts Chart Styles
Chart1 v Je |
A B C D E F G H |

1 ID Before race |After race |Increase %

2011 4.3 @ 28 8 SR04

- g After race

453 5.2

5 4 5.2 | 50

65 6.6 | 45 ®

7 |6 7.2 | 40 °

8 7 8.4 | 35

9 8 9.0 | 30 L&

10 9 10.4| 25 % 2 # After race

11 10 14.0 20 *

12 11 17.6| 15 ” &

13 Average 8.4 10

14 >

15 0 ‘ | | |

16 0.0 5.0 10.0 15.0 20.0 |
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2. Changing the Scatter Plot
Design

1. Move the chart to a separate sheet (as
described above)

2. Move the sheet Chart1 to after the sheet Blood
plasma

3. Change the chart style to Style 4
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3. Change the Scatter Plot
Layout and Format

1. Change the chart title to “Scatter plot of blood plasma
beta endorphin concentration (pmol/l) before and after

the race”

Change the chart title font to 24 point Arial

. Remove the legend

. Add a horizontal axis title of “Before race”

. Add a vertical axis title of “After race” written horizontally
. Change their font to 18 point Arial

. Change the axis labels font to 16 point Arial

N o oA wWN
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8. Double click on the
data markers. This
opens the Format
Data Series
dialogue box.

9. Change the marker

size using the
Marker Options —é

Built In, 12

10.As before, change
the background
colour of the chart
to light yellow using
the Format ribbon
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This should create a scatter plot that looks like this:

Scatter plot of blood plasma beta endorphin
concentration (pmol/l) before and after the race

45 ®

40

35 + *

30 L\ 2B 4

After race 25 * r
20 4
15 *

10

5

0

0.0 50 10.0 15.0 20.0
Before race

11. Save the file and close it
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Using pivot tables to create a
multi series bar chart

1 Copy the file SurveyData2 from the SExcelCharts folder
in the iCity site below and save it as SurveyData4 in the
folder SExcelCharts on your computer

O Open this file

d Go to sheet GenderHeight

4 Click within the pivot table

O Select the Options tab and the button PivotChart

\

i (4 [+ SurveyData2 - Microsoft Excel l otTable Tools ‘ o B R
Home Insert Page Layout Formulas Data Rey Options Design o O o ep 2R
PivotTable Name: Active Field = l 4‘] j 4 _;J'/ Clear ~ J_K‘J flfj PivotChart Z Field List
PivotTablel Count of Gender s ‘—I Gl select ~ ~ +L) /- Buttons
- | t Re f sh Change D ta Calculations

#f Options ~ | @y Field Settings = | &3 5| 5,_J c &) Move PivotTable v 5 Field Headers
PivotTable Active Field Group Sort & Filter
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] Select the default chart and click on OK
1 This should create a chart like this:

150-130 2.277h L7117 1,937

Count of Gender
45.00%
40.00%
35.00%

30.00%
25.00% Gender

20.00% W Female

15.00% mMale
10.00%
5.00%
0.00% -

120-130 130-140140-150 150-160160-170 170-180180-190

P

d
4 Right click on one of the grey buttons and select Hide
All Field Buttons on Chart

 We shall keep this chart on the same sheet
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1 Add a title above the chart "Height Percentage
Frequency Distribution against Gender”

1 Change the number of decimal places of the
vertical axis to O

] Add a rotated title to the vertical axis of
“Percentage frequency”

1 Add a title to the horizontal axis of “Height (cm)”

1 Change the colour of the Female data series to
pink and the Male data series to Blue

1 Change the background colour of the chart to
light yellow
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 Increase the size of the chart to 12cm by 20cm

using size fields in the Format tab N

Chart Area
\‘{‘/ Format Selection
jP et to Match Style

wll = % A | = =
X 9 & 9, [+ SurveyDataExample - Microsoft Excel ‘ votChar
“ Home Insert Page Layout Formulas Data Review ew Design Layout Format An

D shape Fill

Ik I>

OO0 A A

- St Effects

]
v | 4y Selection Pane

‘ o B 2R
alyze 6@ o @ R
= A U . u
_I°'_ 3] 12 em .
Pane o4 20cm :
range Size

d Change the font of all the text to Arial:

> C
> C
> C

nange t
nange t

nange t

ne chart title to 16pt

ne axis titles and legend to 14pt

ne axis values to 12pt

 You may need to adjust the size of the chart
and the position of some of the labels slightly
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Your completed chart should look like this:

Height Percentage Frequency Distribution against Gender

45%

20% Female

m Male

Percentage frequency

0% || [ |

T T T T T T

120-130 130-140 140-150 150-160 160-170 170-180 180-190
Height (cm)

Save your file and exit
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Recap

We have looked at creating:
1 Pie charts

1 Single series bar charts
1 Scatter plots

d Multiple series bar charts from pivot tables
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